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Introduction 
 
MapEditor is a Java module which enables custom editing of canonical pathway maps 
available in MetaCore, conversion of networks into map visualizations and drawing 
regulatory and metabolic maps from scratch. A user may choose the objects for his/her 
maps from the MetaCore content of genes, proteins, compounds and interactions, or 
introduce new objects.  Custom maps can then be securely “published” (added to 
MetaCore’s standard map collection on the customer’s server); used as a template for 
mapping experimental data and/or saved and shared with colleagues. In fact, a user can 
focus and organize his/her wet lab or dry lab research around a set of interactive maps 
created in MapEditor and linked to MetaCore. The custom set of maps can then be 
“published” and available in the comprehensive context of modern human biology 
presented in MetaCore as a set of 500+ canonical signaling and metabolic maps. The user 
is then able to work with a vast body of high-throughput data (for instance, disease 
specific microarrays expression experiments) available internally or in public domain 
databases on his/her maps. The data can be parsed in MetaCore, placed on custom and 
standard maps; the maps can be aligned according to relevance to imported data, the gene 
content from multiple maps exported or explored further.  Such capability of “meta-
analysis” could substantially expand the focus of research of any biologist or medicinal 
chemist, regardless of access to proprietary high-throughput data. The custom maps can 
be shared confidentially within a customer’s user group accessing their internal MetaCore 
server. 

Accessing the Map Editor 
 
Java 1.4.2 (except Java 1.4.2_06 and 1.4.2_07) is required on the client computer.  If Java 
is not present it is automatically installed on the client computer when Map Editor is first 
accessed.  Users can access the Map Editor by following the link on the MetaCore 
homepage (Figure 1).  After clicking on the link the Map Editor client side software will 
be automatically installed.  After the software is finished installing the Map Editor will 
open and ask for a database connection. 
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Figure 1: Accessing the Map Editor. 

Connecting to the Database 
 
In order to use the Map Editor, you first need to connect to the MetaCore database.  
When the editor is first opened the connection dialog box is opened as well.  Select the 
server to connect to in the Connection drop-down menu and enter your account name and 
password.  Then click the Connect button (Figure 2). 
 

 
Figure 2: Server connection dialog box. 
 

Click here to access 
the Map Editor 
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Navigation 
 
The Map Editor tool is comprised of multiple windows and panels.  The Add Objects and 
Properties windows are open by default.  These windows can be “docked” into the main 
Map Editor window by holding Ctrl and clicking-and-dragging on the window header.  
This will create a section colored in blue where the window will be docked; release the 
mouse button to dock the window.  A docked window can be “un-docked” by clicking 
the arrow button in the upper right corner of the window (Figure 3).  Opened maps are 
initially docked into a number of tabs.  The tabs can be un-docked in a similar fashion. 
 
The Add Objects panel contains a number of tabs for searching for specific objects, 
adding localizations, and adding labels.  Click the arrow buttons in the upper right corner 
of the Add Objects panel to scroll through these tabs. 
 
A number of button groups are also available at the top of the Map Editor.  These groups 
can be undocked from the main window by clicking-and-dragging on the left bar of the 
group.  A button group can be re-docked by dragging it back to the top or by clicking the 
close button.  Many of the buttons’ functions are also available in the menus at the top of 
the Map Editor. 
 

 
Figure 3: The Map Editor 
 

Docked Properties 
window 

Undocked Add 
Objects window 
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Button overview 
 
Below is a brief description of the Map Editor toolbar buttons: 
 

 - Use this drop-down menu to zoom in or out to the selected percentage.  
Click the “magnifying glass” button to fit the map in the window. 
 

 - Click this button to open a new map. 
 

 - Click this button to save the active map to an XML file on your desktop. 
 

 - Click the button to close the active map. 
 

 - Click this button to publish the active map for use in MetaCore. 
 

 - Click this button to open a previously saved map XML file. 
 

 - Click this button to open the Map Browser which allows you to open a GeneGo 
map in the editor. 
 

 - Click this button to open a saved network in the Map Editor. 
 

 - Click this button to open the “Search objects on map” panel.   
 

 - Click this button to edit the map’s name and description. 
 

 - Click this button to edit the map’s dimensions. 
 

 - Use these buttons to undo or redo actions respectively. 
 

 - Use these layer buttons to move the selected objects or localizations 
forward or backward. 
 

 - These are alignment buttons.  Use these buttons 
to align the selected objects along a given line. 
 

 - Use these buttons to spread the objects on the map out, or move the objects 
closer together. 
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- When this button is clicked, use the cursor to select, move or edit objects and their 
properties. 
 

 - When this button is clicked, use the cursor to add interactions between objects by 
clicking on them. 
 

 - When this button is clicked, use the cursor to zoom in to a specific place on the 
map. 
 

 - When this button is clicked, use the cursor to zoom out from a certain place on the 
map. 

Opening a New Map 
 
Click the New Map button to open a new map.  New maps initially contain the cytoplasm, 
nucleus, and membrane localizations.  Additional objects, interactions and localizations 
can be added to the map using the Add Objects panel. 
 

 
Figure 4: Opening a new map. 

A new map contains 
cytoplasm, nucleus, and 

cellular membrane 
localizations by default

Click here to open 
a new map 
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Adding Objects 
 
Tools to add objects to the map can be accessed from the Add Objects panel (Figure 5).  
The Add Objects panel is open by default when Map Editor is started.  To open the panel 
after it has been closed, select Add Objects from the Windows menu.  The panel contains 
options to search for objects in the MetaCore database: network objects, chemical 
compounds, proteins, and reactions.  The Add Objects tool can also be used to add links 
to other maps in MetaCore, custom objects, localizations, and labels.  Use the arrow 
buttons in the upper right corner to scroll through the available tabs. 
 
To add a database object, first search for it. To search by ID number, check the box next 
to ID and enter the number in the box to the right.  After entering the query click the 
Search button.  The Results will then appear.  Click and hold on a result.  Then drag it 
over to the map window to place the object (Figure 5). 
 

 
Figure 5: Adding an object. 
 
The object will then appear on the map.  Then a window will pop up containing the 
interactions between the newly added object and any other objects on the map.  Select the 
interactions you wish to add, and click OK.  You can click and drag the object to move it.  
After clicking on an object, the object’s properties will appear in the Properties window 
(Figure 6).  

1. Search for an 
object in the Add 
Object window 

2. Click-and-drag 
a result to the map 

to place it 

3. Choose to add 
any interactions 

with existing 
objects on the map 
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Alternatively, you can double-click on a search result to have the object automatically 
placed in its associated localization (if the localization is present on the map).  If the 
object is “dragged-and-dropped” to a location outside its associated localization, the 
localization will be placed below the object. 

Object properties 
 
The properties for objects include: 
 

- Localization: If localization organelles are present in this drop-down menu, 
one can be selected so that the editor will report a warning if the object is 
placed outside that localization on a map. 

 
- Complex: Checking this box will place a white star on the object, signifying 

that it is a complex of multiple genes/proteins/molecules. 
 

- Errors/Warnings: A message will appear here in red if there is an error or in 
yellow if there is a warning. 

 
- Icon: Click this button to open a window containing all the available map 

icons.  Click on an icon in the window to change it if desired. 
 

- Name: This is the name of the object as it appears on the map.  After 
changing the field, press enter for the change to appear on the map. 

 
- ID:  This is the object’s database ID number. 

 
- Tooltip: The text that appears when you mouse over the object on the map.  
 
- URL: The address opened after clicking on the object (the map needs to be 

published and opened in MetaCore). 
 
After editing a text property, press Enter on your keyboard to keep the changes. 
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Figure 6: Object properties. 

Creating a custom object 
 
If you cannot find the object you wish to add to the map, you can create a custom object 
by selecting the Custom objects option in the Add Objects window.  Click and drag the 
custom object onto the map (Figure 7).  Then click on the object on the map and edit its 
properties in the Properties window.  You can then create interactions to and from that 
object just as with any other object (see below). 
 

Click on an object to 
see its properties 
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Figure 7: Adding a custom object. 

Creating a label 
 
You can add labels to a map as well.  Choose the Labels option in the Add Objects 
window.  Then click and drag the desired label to the map.  Then click on the label.  You 
can edit the label’s properties to enter the label text, specify the font type and size, enter a 
tooltip, and change the font, border, and background color.   The border’s shape can also 
be changed by changing the values in the ArcHeight, ArcWidth, and BorderWidth fields 
(Figure 8).  Labels can be moved and linked to like any other object on the map. 

Label properties 
 
Labels have some additional properties: 
 

- Font: You can change the font type and size for the label text by using the 
drop-down menus. 

 
- Font Color: Choose a color by clicking the “…” button to the right of the 

current color.  Then select a color from the swatches. 
 

1. Click and drag the 
custom object to the map 

2. Then edit its 
properties 
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- BorderColor: The background color can be specified in the same manor as 
the font color. 

 
- BackgroundColor: The background color can be specified in the same manor 

as the font color. 
 

- ArcHeight and ArcWidth: Enter numbers here to change the shape of the 
label. 

 
- BorderWidth: Enter a number here to specify the thickness in pixels of the 

label border. 
 
After editing a text property, press Enter on your keyboard to keep the changes. 
 

 
Figure 8: Adding a label. 

Adding Interactions 
 
To add an interaction, first select the link tool in the toolbar (the cursor will change to a 
dark black arrow) (Figure 9).  Then click on an object; this object will be the source 
object.  Then click on a second object for the target (it can be the same object as the 
source).  After clicking the target a window will appear to create the interaction.  If an 

1. Click and drag 
the label to the map 

2. Then change the 
label’s properties 
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interaction between the two objects is already present in the MetaCore database it will be 
listed in the DB Links tab.  Select the interaction and click Ok to place it on the map 
(Figure 10). 
 
Alternatively, you can click the Custom link tab to create your own interaction.  The 
custom tab contains options for specifying the interaction’s effect and mechanism.  
Possible effects include unspecified, activation, inhibition, and “No effect”.  Possible 
mechanisms include unspecified, any covalent modification, phosphorylation, 
dephosphorylation, binding, competition, transformation, cleavage, transcription 
regulation, class relation, influence on expression, complex subunit, catalysis, transport, 
transport catalysis, and “No mechanism”.  If “No mechanism” or “No effect” is specified, 
the interaction hexagon will not appear on the interaction arrow.  You can also enter a 
mouse over tooltip if desired.  The interaction can be made non-directional (no arrowhead) 
by un-checking the “make directed interaction” box.  When finished creating the link, 
click the Add button to add it to the map (Figure 10). 
 
To change the effect or mechanism of an interaction from the MetaCore database, first 
click the Custom box in the interaction’s properties.  Then the effect and mechanism 
drop-down menus will become active (Figure 12). 

Interaction properties 
 
As with Objects, clicking on an interaction hexagon will bring up its properties on the left 
(Figure 12).  The properties include: 
 

- Effect: The interaction’s effect can be changed in this drop-down menu. 
 

- Errors/Warnings: If details of the interaction (effect, mechanism, to and 
from nodes) differ from an interaction in the database between the same nodes 
an error or warning will be listed here. 

 
- ID: Displays the ID number for the interaction if it is present in the MetaCore 

database.  Custom interactions have an ID of “none”. 
 

- Mechanism: The interaction’s mechanism can be changed in this drop-down 
menu. 

 
- Tooltip: The mouse over tooltip text displayed in MetaCore can be entered 

here. 
 

- URL: The URL of the page that is opened when the user clicks on the 
interaction hexagon after the map has been published to MetaCore.  Click the 
“go” button to open the URL from the Map Editor. 

 
- Directed: Un-checking or checking this box will remove or add an arrowhead 

to the interaction. 
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- Visualization: This drop-down menu contains the different arrow shape 
options (see below). 

 

 
Figure 9: Creating an interaction. 
 

        
Figure 10: An interaction that is already present    Figure 11: Creating a custom interaction. 
in the database. 

1. Select the Link 
Tool here 

2. Click on source 
and target objects 
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Figure 12: Viewing interaction properties. 

Interaction visualizations 
 
There are six visualization options for interaction arrows (Figure 12).  Using these 
options you can shape the arrows to fit your map.  In all cases, double-click on the 
interaction hexagon to bring up the red adjustment squares.  After double-clicking, you 
can also click and drag the hexagon to move it to another location on the arrow.  The 
different interaction visualizations are: 
 

- Default: This is simply a straight arrow.  Double-clicking the interaction will 
only allow you to move the hexagon. 

 
- Round: Selecting this option will create a curved arrow.  After double-

clicking on the interaction a red box will appear in the center.  Click and drag 
this box to set the amount of curvature desired. 

 
- Polyline: This option will allow you to create multi-angled arrows.  After 

double-clicking on the interaction, left-click on any location along the arrow.  
A red square will appear.  Click and drag the square to create the desired angle.  
You can place and drag multiple squares to create multiple angles in the arrow.  
Right-click on a red square to remove it and its angle. 

1. Click on an 
interaction hexagon 

2. Properties are 
displayed here 

3. Interaction arrow 
visualization styles 

Click the Custom button 
to make a database 

interaction a custom 
interaction 



 16

 
- Right angle line: This option will create an interaction with one right angle.  

After double-clicking on the interaction a red square will appear at the right 
angle.  Click and drag the square to place the angle in the desired location. 

 
- Right angle polyline: This option is similar to polyline, it allows you to 

create multiple right angles in the interaction arrow.  Double click the 
interaction, and then left click on it to create another right angle.  The arrow 
can be adjusted by clicking and dragging on the red squares.  Right-click on a 
red square to remove it and that angle. 

 
- Bezier: This option allows you to create an interaction arrow in the shape of 

an “S” curve.  After double-clicking on the interaction, two red squares will 
appear.  By clicking on and dragging these squares you can form the arrow 
into an “S” curve (Figure 13). 

 

 
Figure 13: Editing a Bezier style interaction arrow. 
 
 
 

Double click the interaction and 
move the red squares to shape 

the arrow.  Here a Bezier arrow 
is being adjusted. 
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Adding Localizations 
 
Localization images can also be added to the map.  These localizations can be used to 
represent how genes in one part of the cell can affect genes in another part of the cell, for 
example.  Possible localizations include Golgi, EPR, Lisosome, Membrane, Mitochondria, 
Nucleus, Peroxisome, Cytoplasm, and Extracellular.   To add a localization image, select 
the Localizations tab in the Add Objects window and then click and drag the desired 
localization onto the map (Figure 14).   
 
Localizations can be resized by first clicking on them.  Eight black squares will appear 
around the localization image.  Click and drag on one of these squares to resize the 
localization (Figure 14). 
 

 
Figure 14: Adding the EPR localization. 

Localization properties 
 
Localizations also have various properties: 
 

- DrawChildren: Unchecking this box will make any objects in the localization 
disappear. 

 

1. Select Localizations 

2. Choose the 
localization and drag 

it to the map 
3. Click a localization 

to resize it 
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- Lock: If this box is checked any objects in the localization will be locked in.  
You will not be able to move them outside of the localization image. 

 
- MoveWithChildren: When this box is checked and the localization image is 

moved, any objects in the localization will move as well. 

Saving a Map 
 
A map can be saved in two formats.  To save a map so that you can work on it later, first 

click the Save map button ( ) or select the Save map option from the File menu, then 
in the window that pops up, browse for the folder in which to place the file and click 
Save.  The map will be saved as an XML file.  You can also save the map as an image 
file.  First, select Save image from the File menu.  Then choose a resolution in the 
window that appears and click Ok.  Then browse for a location, give the image a name 
and click Save.  The image is saved as a PNG file. 

Opening a Saved Map 
 
To open a map previously saved to your computer (in XML format), first click the Open 

map button ( ) or select Open map from the File menu.  Then browse for the file and 
click Open.  The map will be opened in a new tab. 
 

 
Figure 15: Opening a saved map. 

1. Click the Open 
Map button

2. Then browse for 
the XML file
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Publishing a Map 
 
Publishing a map makes that map available for viewing and mapping experimental data 
to within MetaCore.  To publish the active map in the editor, first click the Publish map 

button ( ) or select Publish map from the File menu.  Then choose the folder in which 
to place the map, by default the map is placed in the Custom Maps folder.  Finally, click 
Ok (Figure 16).  When it is finished processing, the map will be available for viewing 
and data mapping in MetaCore. 
 

 
Figure 16: Publishing a map to MetaCore. 
 
 
 
 
 
 
 
 
 
 
 

1. Click the Publish 
button

2. Select a folder 

3. Click Ok 
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Opening a Saved Network 
 
Networks saved in MetaCore can be changed into static maps using the Map Editor.  In 

the editor, click the Open Network button ( ) or select Open network from the File 
menu.  In the window that opens select the network to open as a map.  You can simply 
scroll through the list or you can type a partial name in the box provided.  The list will 
automatically scroll to the nearest match as you type.  Select the desired network and 
click Ok (Figure 17).  The network will open in a new tab in the editor.  Objects, 
interactions, and localizations can be added and removed as with any other map in the 
editor. 
 

 
Figure 17: Opening a saved network. 
 
 
 
 
 
 
 
 
 

1. Click Open network 

3. Select a network 

4. Click Ok 

2. Enter a search query 
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Editing an Existing MetaCore Map 
 
Existing maps in MetaCore, created by GeneGo, can be opened and edited in the Map 

Editor.  To do so, first click the Map browser button ( ) or select Map browser from 
the File menu.  In the window that appears, select the map from the various folders 
present on the left.  You can also enter a search query to search the maps by name.  The 
browser will automatically jump to the closest match as you type.  Then click the Load 
button (Figure 18).  The preview window will close and the selected map will open in a 
new tab in the editor.  Objects, interactions, and localizations may be added or removed 
as with any other map in the editor. 
 

 
Figure 18: Opening a GeneGo map. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Select a map in 
the folders 

3. Click Load to 
open it 

1. Enter map name 
search query 



 22

Searching a Map 
 
You can use the “Search objects on map” panel to search the open map for objects by 
name or ID.  Enter a name or ID in the box at the top and click Search.  If you enter an ID 
number, select ID in the drop-down menu to the left of the search box.  The results will 
be listed in the lower window.  Click on a result and the object will be circled in blue on 
the map. 
 
 

 
Figure 19: Searching the map for NF-kB. 
 
 
 
 
 
 
 
 
 
 
 
 

2. Enter a search query 
and click Search 

3. Select a result; it will be 
circled on the map 

1. Check “Search 
objects on map” from 
the Windows menu 
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Other Options 

Adjusting map size 
 

The size of the map can be adjusted by clicking the Page setup button ( ) and entering 
a new Height and Width in the box that appears.  After expanding the map size, click the 
Expand buttons to spread the objects apart so that they fit better in the expanded map 
space (Figure 20). 
 

 
Figure 20: Adjusting the map size. 
 
 
 
 
 
 
 
 
 
 
 

1. Click Page setup 

2. Enter a new 
Height and Width 

and click OK 

3. Click the Expand 
button to spread the 

objects apart 
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Map properties 

The properties for the map can be accessed by clicking the Map properties button ( ).  
In the window that appears, you can give the map a name and a description.  Click Ok to 
apply any changes made (Figure 21). 
 

 
Figure 21: Map properties 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Click Map 
properties to open the 

properties window 

2. Make any desired 
changes and click Ok 
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Display warnings and errors 
 
Objects and interactions that have errors or warnings can be marked on the map by 
checking the Show errors and Show warnings checkboxes in the View menu.  Errors are 
circled in red and warnings are circled in yellow.  The error or warning description is 
displayed in the interaction or object properties section (Figure 22). 
 

 
Figure 22: A warning for an incorrect localization placement. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Turn errors and 
warnings on in the 

View menu 

2. Click on an object 
with an error or 

warning to see to see 
the message
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Published Maps in MetaCore 
 
After publishing a map from the Map Editor, the map becomes available in your account 
on MetaCore.  The map will appear in the MAPS folder in the Data Manager.  Published 
maps can be shared, renamed and deleted from the Data Manager, just like experiments 
uploaded to MetaCore.  Double-click on the name to view the map.  When active data 
contains genes from the map, the custom map will appear in the list generated from the 
View->Maps option and data thermometers will appear on the custom map. 
 

 
Figure 23: Published maps in MetaCore. 

Published custom 
maps appear in the 

MAPS folder 

Similar actions can be 
performed with 

custom maps as with 
experiments
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